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Introduction 

 
Security information 

Keep your TrendStuffer package and files safe, don't share it with anyone else because every package 

we send out is unique and if we experience abuse we reserve the right to suspend the software and 

support until the case is investigated. 

Also keep your TrendStuffer official webpage login name and password safe to avoid unnecessary 

conflict if someone manages to "break" into your account. 

 

Getting Help 

If you still have unanswered questions after reading this guide, you still have a few options where to 

get information from. I would recommend using the official TrendStuffer forum before anything else. 

Someone of the TS team visits the forum every day and tries to answer the questions which appear 

there and discuss everything else with the users. Fortunately we have about 150 forum users already 

and some of them are very helpful and try to do everything they can to guide the newcomers. 

If you have a confidential question that has no place in the forum, you can always write an e-mail to 

info@trendstuffer.com but due to the very high amount of e-mails we receive day by day please allow 

us a little delay replying to your questions. We'll try to answer to each and every one of these e-mails 

in detail and also make sure that no one gets stuck with a problem. 

 

Other resources 

You can always find more information about the MetaTrader 4 platform at its developer's official 

website, www.metaquotes.net. The software has a built-in automatic update utility that prompts to 

download and install the latest version, and it's highly recommended by us also, to always use the 

newest build available. 

Don't forget to check the TrendStuffer official website every once in a while because we update it 

quite frequently and I assume you don't want to miss out on a great opportunity. 

 

 

 

 

 



TrendStuffer.com    5 

 

The TrendStuffer Trading System 

 

About 

The TrendStuffer System is a complex strategy that does not involve any of the "regular" indicators 

used in financial markets nowadays, like the MACD, RSI or moving averages. It adapts itself to current 

market conditions using complicated algorythms based on price action. 

Important! There are two parts of the system. The manual trading part was designed to help pro or 

semi-pro traders with by adding a tool to their palette which can help them make decisions. We 

provide a template which you can begin with (using the indicator itself and an MTF indicator to 

confirm the trend) but the main goal of the manual system is to let you customize it your own way, to 

your own style.  

The other part is the automatic trading robot - it's called expert advisor in the MetaTrader 4 jargon 

- which trades automatically without any need of human intervention. You just set it up and attach it 

to a chart (in the TrendStuffer case usually a GBP/USD chart) and leave it there running 24/7 on a 

machine that you never switch off. It produces extremely good results without the need of any forex 

trading knowledge. 

History 

After spending thousands of hours trying to find the perfect system (often referred to as the "holy 

grail" in Forex jargon) which can make money in any market conditions on any currency pair we came 

up with the basic idea of the TrendStuffer system. After building the first version of the expert advisor 

(automatic trader software) we immediately realized that it has a huge potential but needs more 

polishing. In the summer of 2006 we built several versions of the EA and decided to go live during the 

Fall of the same year, and accepted a few more members in this private testing phase. From their 

feedback we developed the manual trading part of the system you can read more about it in the 

About section above. 

After releasing the software to the public, a few updated versions have been already sent out to 

customers but that's only the top of the iceberg.  

There are still a lot of things to do with this great system, for example optimizing for other pairs 

besides Cable, developing more types of EAs with additional filters and functions, etc. It is certain 

though, that we'll focus on the automatic part of the system, because we think it has a lot more 

potential than the manual version which requires a lot of human intervention and thinking and serious 

decision-making. 

Why is it good for you? 

Because it makes you money, good and passive income one should say. Passive is the key word, 

because you literally don't have to do anything and it gives you a yield that no regular bank offers. 

This is the beginning of the modern era, when you and me and all the other small investors have 

access to a market which 15 years before was available for huge interbanks only.  
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The MetaTrader 4 platform 

About 

MetaTrader 4 Client Terminal is the client part of online trading 

platform MetaTrader 4. The program has a simple and user friendly 

interface that allows traders to monitor their transactions and their 

account as well as perform technical analysis and develop trading 

strategies of their own. It is the best solution for trading on Forex, 

CFD and Futures markets. 

Client terminal MetaTrader 4 key features: 

●  working with securities of Forex, Futures and CFD markets;  
●  various execution technologies: Instant Execution, Request Execution, Market Execution;  
●  confidentiality of all trading operations;  
●  unlimited charts quantity;  
●  support of various timeframes (from minutes up to months);  
●  large number of technical indicators and line studies;  
●  experts, custom indicators and scripts;  
●  more than 20 supported languages;  
●  realtime data export via DDE protocol;  
●  signals of system and trading actions;  
●  getting on-line news from financial markets;  
●  internal e-mail system;  

●  printing charts and completed trading transactions statemets. 

Expert Advisors 
 
The Expert Advisors technology is a new method of trading which frees you from daily manual 
routines. Expert Advisor written in MetaQuotes Language 4 (MQL 4) automatically analyses current 
market situations, opens/closes positions and places/modifies/deletes orders. 
 
With the help of Expert Advisors you can:  

1. avoid everyday manual routines by automating the process of trading and monitoring orders;  
2. be more scientific and rational in your decision making process;  
3. keep track of the current market situations.  
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Installation 

MetaTrader 4 Client 

1.) Download the latest build of the MetaTrader 4 Client from the official website of MetaQuotes Corp. 

(use the link below) or use the link provided by your broker company. 

http://www.metaquotes.net/files/mt4setup.exe 

2.) Run the mt4setup.exe file the same way you launch any Windows program. 

3.) After the following menu pops up, select your language and click "Next >". For easier 

understanding we'll use the English interface of the MetaTrader 4 Client. 

 

4.) Read the following notice and then click on the "Next >" button again. 
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5.) If you agree to the license agreement check the box "Yes, I agree..." and click the "Next >" 

button once again. 

 

6.) Select the folder you want to install MT4 to, or just leave the default value, and click "Next >". 

 
 

7.) On this screen you can select the folder in your start menu you would like the MT4 icons/shortcuts 

added to. You can select a folder or just leave the default values and hit "Next >". 
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8.) The installation is now ready to begin, so just hit the "Next >" button and it will start immediately. 

 

9.) Sit back and relax while the installation process finishes. 

 

10.) After the installation is complete you can immediately start the MetaTrader 4, but it is advised to 

install the TrendStuffer System first, because MT4 has to be closed when you install TrendStuffer. 

Click "Finish" to exit the installation 

program. 
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TrendStuffer Trading System Installation from ZIP archive 

The package contains: 

- 2 files in the experts\indicators folder 

- 1 file in the experts folder 

- 1 file in the experts\include folder 

- 1 file in the experts\libraries folder 

1.) Unpack (decompress, extract) the ZIP file to an empty folder. Copy the following files from the 
experts\indicator folder to the "experts\indicators" folder in your MetaTrader 4 folder. 
eg.: C:\Program Files\MetaTrader 4\experts\indicators  
TrendStuffer-v4-base-trial.ex4 
TrendStuffer-indicator-v4-trial.ex4 

2.) Copy the following files from the experts folder to the "experts" folder in your Metatrader 4 folder. 
eg.: C:\Program Files\MetaTrader 4\experts  
TrendStuffer-v4-trial.ex4 

3.) That's it, manual installation done! 

Using the TrendStuffer Trading 
System 

Starting the MetaTrader 4 Client 

After you've finished the installation procedure, you can start the MetaTrader 4 Client from your 
desktop or from the Start menu via MT4's shortcut. 
 
Attention! If the MT4 Client was running while you installed the TrendStuffer package, you have to 
restart MT4 (exit and start it again), otherwise you won't be able to use the TrendStuffer System. 
 
Once you've started the terminal, it will ask you if you want to register a new demo account, or - by 
cancelling this sub-window - you want to sign in to an existing account with your login name and 
password provided by your broker company. 
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You should see this window when you first start the MetaTrader 4 Client. 

If you want to create a new demo account, fill out the form you can see in the middle of the 
screenshot above. It's free and most brokers don't set time-limits neither, so you can use it for as long 
as you want. I would recommend setting a deposit amount about 100.000($) remember, it's only play 
money and you don't want to throw it away too soon while you're only experiencing with the 
interface. 

Configuring the Expert Advisors 

Attaching and expert advisor to a chart is very easy. After that you'll have to configure it to meet your 

trading style - or alternatively you can just keep the default settings - and start it with a click of a 

button. 

To add an expert advisor to your chart, first open a fresh chart by clicking File->New chart->GBPUSD. 

You should check that the chart is on the same TimeFrame as the EA should be. You can now this 

from the filename of the EA: TrendStuffer-v4-final.ex4. Best timeframe is used for each pair and they 

differ from each other obviously, based on price action, trendedness, etc. Please refer to the table of 

timeframes at the end of this Guide for more information. 

 

By default you have the Navigator window opened in your MetaTrader 4 on the left side, but if not, 

click View -> Navigator, or Ctrl+N hotkey. In the Navigator window it's easy to find the Expert 

Advisors section, from there you have to select the "TrendStuffer-v4-trial" file. 

Click on it, hold down the mouse button after clicking and drag'n'drop the file on your chart. The EA is 

now attached to the chart. A popup dialogue will ask you a few things how would you like to handle 

this EA. 

Even if it's a demo account, CHECK the "Allow live trading" box, and DON'T CHECK the "Ask for 

manual confirmation". Be 100% sure to enable (tick the checkbox) “Allow DLL imports”, otherwise it 

will not work.  Now let's move on to the Inputs tab in this popup window, that's where the real fun 

begins. 
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EA parameters 

UseMicroLots: Setting this as ‘True’ means enabling your trade to use micro lots, such as for 
example: 0.01, 0.56, 1.45 and so on. Please be SURE that your broker and account supports trading 
Micro Lots before turning this on. If your broker or account does not support it, and you have it set to 
‘True’ your broker might reject your order, then the order will not be filled. If your broker and account 
supports the use of Micro Lots, then it is recommended to have this set ‘True’ for reason being it 
would help to calculate the correct percentage of each position better, otherwise, the lowest lot size 
it’ll use would be 0.1 lot. 
 
MaxSlippage: Default value is set to 5 pips. This is the maximum slippage allowed for your broker to 
fill your order. For example: If the EA places a Buy @2.0450, you will allow the broker to fill the order 
at any price between 2.0450 to 2.0455 in case the price starts to move away. If the price moves too 
fast and passes 2.0455 before your order can be filled, then you order will not be filled. This is to 
protect orders being entered way off the price you wanted. 
 
OrderTriesNumber: Default value is set to 10 times. This is the number of times the EA will keep 
trying to get the order filled by the broker. At times when the price is moving fast, it might take more 
than one try to get the order through to the broker.  
 
StartHour: Default value is set to 0, which is 00:00 (broker time). This is the time the EA will start 
trading for the day. (with the default start and end hour settings, the EA will be trading 24 hours a 
day) 
 
EndHour: Default value is set to 24, which is 24:00 (broker time). This is the time the EA will stop 
trading for the day. In this case, it will never reach since the day only goes to 23:59. 
 
ExpirationHour: Default value is set to 24, which is 24:00 (broker time), or OFF as 24:00 will never 
hit as 23:59 turns to 00:00. This is the time the EA will close ALL open positions placed by the 
Trendstuffer EA. 
 
DetailedLog: Default value is set to 1 which is True. If set at 0, it would be False. This will provide 
you detail logs of many different information under the Experts tab located on the bottom of your 
platform. 
 
LotCalc: Default value is set to 2 (Automatic calculations). This is where you can choose if you would 
like the EA to calculate your lot size. Automatic calculations will only use the percentage risk you’ve 
allowed it to use. If you would like to use the Manual lot size entered, then enter 1 (Manual input) 
here.  
 
MaximumRisk: Default value is set to 5 (5%). This is where you can adjust the Maximum Risk in 
percentage you would allow the EA to use per trade for the Single Position Strategy.  
 
 
LotSize: Default value is set to 1.0 lot. This is where you can enter your own lot size to use if you 
choose the Manual input to calculate the lot size.  
 
TSSMagic: This is the Magic Number used. Each EA’s Magic Number MUST be different from each 
other within its own EA and other EAs being used. This is so that the EAs won’t confuse positions 
entered by other EAs and try to make adjustments to trades it didn’t place. This number can be 
changed to any number you like as long as it is different from other Magic Numbers. However, DO 
NOT change the Magic Number of the EA when there is a position already opened by it. The EA 
remembers the trade it placed by the Magic Number attached to it when it opened. If you change the 
Magic Number during an open trade, the EA will not see that trade anymore and will not make 
anymore adjustments to it. 
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TakeProfit: Default value is set to 800.0 pips. This is the Maximum Take Profit the EA will use for the 
position. Once it reaches this number, the position will close. However, do understand that this 
number will more than likely not be reached. It is set this high so that the position will be allowed to 
ride the trend for as long as it can before the trend indicator changes its trend (color), for which then 
it will exit the position. Most exits will either be caused by the changing of its trend indicator or upon 
reaching its SL/Adjusted SL. 
 
StopLoss: Default value is set to 400.0 pips. This is the maximum Stop Loss(SL) the EA will use for 
the position. Once it reaches this number, the position will close. However, do understand that this 
number is not always hit, as more than likely, the position will exit before hitting this SL as its trend 
indicator changes its trend (color).  
Attention! Because StopLoss represents the worst case scenario, automatic lot calculation depends 
on it. If you set this higher/lower, automatic lot calculation will change also. Higher value means less 
lots for the same trade, while lower value (more “secure” trade) means more lots for the same trade! 
 
UseTrailingStop: Default setting is ‘false’ OFF, but can be changed to ‘true’ ON, if you would like to 
use the default trailing start/stop values, or your own values. (Note that the EA already has an Auto 
Trailing feature build in, and will automatically readjust its SL as the price moves. This feature is so 
you could use your own Trailing Stop values and not the EA’s default values) 
 
TrailingStart: Default value is set to 70 pips. This is when you would like your Trailing Stop to start 
its adjustments. It can be changed to any value of your choosing if you choose to do so.  
 
TrailingStop: Default value is set to 110 pips. This is the distance the trailing stop loss will follow 
your position. 
 
UseBreakEven: Default setting is ‘false’ OFF, but can be changed to ‘true’ ON, if you would like to 
use this feature. What this does is that upon reaching the ‘BreakEvenDistance’ number, in this case 
+20 pips with default setting, it will readjust its SL to the value set in the ‘BreakEvenSLTo’ number, in 
this case to +5 pips with default setting.  
 
BreakEvenDistance: Default value is set to 20 pips. Upon reaching the value entered here, the 
Break Even feature will be triggered, and SL will be adjusted to the ‘BreakEvenSLTo’ value. This can 
be changed to your own preference.  
 
BreakEvenSLTo: Default value is set to 5 pips. This is the value in which the SL will move to upon 
hitting the BreakEvenDistance value. This can be changed to your own preference.  
 

Trading with the Expert Advisors 

So you drag'n'dropped the EA file to the chart and configured everything in the Inputs tab, now hit 

OK. A smiling or a sad face should appear in the upper right corner of your chart. If it's not smiling, 

the EA is NOT trading automatically, and there's something wrong. 

Check the Tools -> Options -> Expert Advisors tab and be sure that the "Enable Expert Advisors (...)" 

option has it's checkbox checked. The "Allow live trading" and “Allow DLL imports” options should be 

checked also. Click OK, and check whether the face in the upper right corner of your chart is smiling 

yet. If not, you haven't done something that I've written in this guide so please read once more the 

"Configuring Expert Advisors" section once more and this section also. 

If you want to disable the Expert Advisor you have a few options to do that: click on the 

 button in your toolbar and the EA will stop functioning. You can remove it from 

your chart by right-clicking somewhere in the chart and selecting "Expert Advisors -> Remove". Or 

you can just close the chart and the EA automatically shuts down. 

Remember, if you want to run the EA 24/7 you WILL need a PC that's running without any 

interruption. If you don't have such computer, you can rent a Virtual Private Server (VPS) or 
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sometimes it's called a Virtual Dedicated Server for about $15/month. I personally use GoDaddy.com's 

service it's reliable and cheap in my opinion.  

Backtesting the Expert Advisors 

If you want to see how the EAs performed in the past, or maybe want to optimize their parameters 

you can do so by using the internal Strategy Tester in your MetaTrader 4 Client. Backtesting can have 

very different results because the modelling quality is different each time you do a backtest if not 

using proper historical data. If you don't get results of 90% modelling quality then your backtest 

results are not reliable at all, and you shouldn't take them seriously, in fact you should discard them 

as they can be very very misleading. 

TrendStuffer V4.0 CANNOT BE BACKTESTED!! It’s a continuously changing trading system 

that gets new values off the Master Server at least once (but often more times) a week! You can 

backtest up to about 6 months but that’s all. 

About the TrendStuffer v4.0 online active updates 

With the debut of the v4.0 edition we have started a service called „online active updates” which 
refers to the update via an internet connection to/from our Master Server which has new, optimized 
values every other day to ensure the highest performance achievable of your own TrendStuffer 
package. We monitor continuously the Forex market, focusing on the 17 currency pairs we offer (as of 
now) and make modifications to the core of each and every one of the TSS v4.0 packs without you 
even noticing it.  

This is a unique solution that is only available for the TrendStuffer customers. 

Get 0-1.5pips spread on EUR/USD and a free copy of TSS v4.0 

MandloysFX is the next step in Forex trading. With the outstanding Introduction Brokering (IB) 
solution we offer you can have unparalleled low spreads accompanied with a powerful arsenal of 
trading tools that will help you survive in the world of trading the financial markets.  

For more information please visit www.MandloysFX.com ! 

Timeframes for the 17 pairs currently supported by TSS 

M15 EURUSD, M15 GBPUSD, M15 USDCHF, M30 USDJPY, M30 AUDUSD, M30 GBPCHF, M15 GBPJPY, 
M15 EURJPY, M30 CADJPY, M15 EURGBP, M15 NZDUSD, M15 EURCHF, M15 AUDJPY, M15 CADCHF, 
M15 USDDKK, M15 USDNOK, M15 USDSEK  
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End of TrendStuffer Trading System 

Official User's Guide 

 

For more information and ordering, please visit: 

www.TrendStuffer.com 

Thank you. 


